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Enhancement of Multispectral Images and Vegetation Indices 
 

ERDAS Imagine 2016 
 
 
 

 
 

Description:  We will use ERDAS Imagine with multispectral images to learn how an image 
can be enhanced for better interpretation. We will also work with a common vegetation 
index to familiarize you to its use. 
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Working with Multispectral Data 
 

Multispectral data is quantitative in nature and represents some measured characteristic in 
each band such as the reflectance or radiance of land cover.  For color infrared photos, each 
pixel has three values, representing brightness in each of three spectral bands, green, red 
and NIR.  The same principle applies to multispectral satellite images, in which each pixel 
has multiple values, one for each of the spectral bands.  Only three bands can be displayed 
at one time on our screens, but any combination of bands can be assigned to the “pen” 
colors red, green and blue.  A common display pattern is red = band 4 (NIR), green = band 3 
(red), and blue = band 2 (green).  This provides a color image similar to color infrared 
photos and is referred to as a “false color IR” image, as opposed to a “true color” image with 
band combination of 3,2,1.   
 
Our image for this lab is a Landsat TM image of Hajdůbőszőrmėny, Hungary in July, and 
shows large agricultural fields and a walled town. [47º40’25”N, 21º30’25”E]. This image 
was chosen for its variety of cover types, the large fields, and the interesting feature of the 
walled town. We will begin by opening the image in ERDAS Imagine. 
 

Set Up: 
1. Log onto the computers as usual and start ERDAS Imagine 2016. 
2. Left Click in the Main menu choose File > Open > Raster Layer or click the open layer icon 

 and navigate to the lab data folder.   
3. Navigate to the Lab02 folder and add the image hg1_2345.img. 
4. If necessary, right click in the 2D Viewer frame and click Fit to Frame. 
 

Imagine will display three bands and will likely default to the typical false color IR 
composite band combination of 4,3,2.  However, this image only contains 4 of the Landsat 
TM bands: 2 (green), 3 (red), 4 (near infrared), and 5 (middle infrared).  Therefore, to 
represent the NIR, Red, Green combination as a false color IR for this case, we would use 
Layer_3, Layer_2 and Layer_1 instead.  Band combinations can be set 
in two ways, using the dropdown options found in the 
“Multispectral” tab under the “Raster” group on the ribbon bar (see 
figure to the right), or by opening the “Set Layer Combinations” box 
using the arrow found below the dropdown options (or use Help 
search: ‘Band Combinations’). 
 
          TM band           Layer Names 
                   
   2 – Green  Layer_1 
   3 – Red  Layer_2 
   4 – Near Infrared  Layer_3 
   5 – Middle Infrared  Layer_4     
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If you click on the small 
arrow the dialog box 
should look like this 
after you select the band 
numbers.  
 
 
 
 

 
If we use the Inquire Cursor tool (recall from Intro to ERDAS lab) and click on an individual 
pixel, we are given information for that pixel for all displayed bands in a popup window.  
Note that the File Pixel values we see here are DN values.  That is, they represent the 
brightness values recorded by the sensor for that location in that particular wavelength 
using units that correspond to the sensor’s quantization rather than physical units.  Higher 
DN values indicate higher radiance. We’ll talk about the LUT Values later. 

 
Using the Inquire cursor tool, explore the image and get familiar with different DN values 
in different land use types (agricultural areas versus urban, etc).  
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Image Enhancement 
 
Sometimes, the range of the original data is less than the range of values available on the 
display device such as a computer monitor.  This range can be adjusted so that the features 
will be more easily distinguishable visually.  In fact, Imagine automatically applies this type 
of adjustment by default when you load an image.  Enhancements that change the DN value 
of each pixel are called point operations.  Enhancements are usually for display purposes 
and may or may not affect how the computer handles the data. 
 
When we first loaded the h1_2345.img, Imagine applied a standard deviation stretch by 
default.  Let’s look at the original image as it would have been displayed without any initial 
enhancement by the software.  
 
Open a New 2D View and add the same image with 3,2,1 selected in Layers to Colors, but 
this time under the Raster Options tab select the box that says “No stretch” before clicking 

OK.  Imagine uses RGB composite when 
displaying the image.  This means that 
each of the three pen colors Red, Green 
and Blue are assigned to a particular 
band of imagery.  This is the usual way 
(but not the only way) of visualizing 
multispectral raster data.  We can easily 
change the layer that is being assigned 
to a given “pen” color. You may want to 
do this now, so you are comparing the 
two image displays in the same band 
combination (recall the steps used 
earlier).   
 

Focus on the 2D view where you loaded the image with No Stretch.  You are now looking at 
the original DN values as they were recorded by the sensor.  
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 You can easily verify this; first, link the two views geographically by clicking on Link Views 

in the home tab  . Then click anywhere inside 2D View #1 to select it and open an 
Inquire Cursor. Move your cursor to a pixel to examine.  
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What values to you see in the LookUp Table (LUT) versus in the File Pixels themselves? 
Now click on the Go to ‘Next Linked Viewer’ button to move to Viewer 2: 

 
Notice how in the cursor window, the legend has changed to View #2 and new values 
appear in the LUT Value column. What are we seeing? 
 
Since our raw image is very dark, we will try several spectral enhancements to determine 
their affect on the appearance of the image.  We also have the ability to change the contrast 
and brightness of the image.  Note that these enhancements are primarily for improving 
our ability to visually interpret the image and do not change the original image information.  
Though we are working with a Landsat image in this lab, we can do this type of analysis 
with any other type of raster imagery. 
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Close the Inquire cursor window and be sure 2D View #2 is selected in your table of 
contents (by clicking anywhere in the viewer) 

   
 If you select Raster > Multispectral – and click on the small arrow box in the corner of 

the Bands to open the Set Layer Combinations box: 
   

 
 

 If you haven’t already done so, change the layers for each pen color so that red is 
assigned to layer 3, green to layer 2, and blue to layer 1 and click OK. 

 
 Now we’ll examine some image stretches. Click on the Adjust Radiometry button in the 

Raster Multispectral ribbon tab 

 
 
A fly down menu will be displayed: 
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 Move your mouse over the choices in the ‘Standard Stretches’ part of the window. 
Observe the preview of the various stretch types in 2D Viewer #2. 

 
 Click on the General Contrast choice in the lower portion of the Adjust Radiometry 

menu 
 
 The Contrast Adjust dialog will appear: 

 

 
 

 Always be sure the Lookup Table is selected in the Apply To choices. This tells ERDAS to 
make your changes only to the look up table and not to the actual data. We’ll look a little 
more closely at some of other stretches now… 
 

 Change the Method to Min-Max and click on Apply and Close. Do you notice much 
change in the image? Why or why not? Hint: Look up Min-Max in the Help system to see 
what it does.  
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 Now go back into the Contrast Adjust dialog, make sure Min-Max is selected and click 
on the Breakpts button.  Adjust the breakpoints for each of the 3 colors so they are 
similar to the following screen.  You can do this by placing your cursor in either the 
upper right or lower left corner of each of the color histograms. The cursor will change 
to a four headed arrow shape. At this point you can drag it along the axis to change the 
slope of the line. Move it until it nears the pixel distribution. Repeat this for each end of 
each color distribution until your screen looks similar to below: 
 

 
Make sure the rest of the settings are the same as above and click Apply All and then 
Close. 

 
 When you click Apply and Close you should see a considerable change in your image. In 

this case, we are using the Breakpoints to tell ERDAS the range that it should use to 
stretch the images for each of the colors.  
 

 Try working with the Linear stretch. Experiment with different Slope and Shift values. 
 

 Now reload the image into a 2D View and 
make sure the No Stretch option is selected. 
Click on the Multispectral Ribbon tab for the 
raster and experiment with the three 
Contrast slider controls on the ribbon bar: 
What do the three slider bars do to the image? Experiment with some of the Filtering 
options. (Note: Filtering will be grayed out if the Contrast Adjust window is still open). What does an 
Edge filter do? 
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Histograms 
 
Before looking at some additional stretches, let’s first inspect the histograms of the spectral 
data and the corresponding statistics.  Recall that a histogram is a graph that shows the 
number of pixels, or frequency of pixels, that occur at each brightness value, or bin, for a 
given spectral band.  An 8-bit Landsat image has 256 levels, or output values, possible.  The 
number of levels corresponds to the radiometric resolution of the sensor.  High 
radiometric resolution allows us to distinguish between more subtle differences in 
reflectance.  (Data that has decimal units, such as Vegetative Indices, may have a different 
number of levels or bins).  Not all bins necessarily have pixels in them.   
 
Open the Metadata for h1_2345.img and click on the Histogram tab (recall from Intro to 
ERDAS lab).  It will not matter whether you have applied a stretch to the image or not, this 
information is from the original image. 
 

   
 
You will see a histogram for Layer 1 that shows the distribution of pixels for that band.  
Take a look at histograms for all the layers by selecting the dropdown box and changing the 
layer.  Notice that most of the original pixel DN values are clustered at the far left, or  
at the darker spectral values.   
 
Also notice that statistical data is provided for each layer in the General tab, including the 
minimum DN value, maximum DN value, and mean are displayed as you move your cursor 
on the histogram.  For instance, the data spread for Layer 3 is 24-150.  This means that the 
data range is only 126 values.  Again, the statistics of the data are based on the original DN 
values, so they will remain the same, regardless of the type of enhancement applied. 
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When we applied the minimum-maximum stretch, the image became slightly brighter, but 
it is still relatively dark.  This stretch treats the histogram like a rubber band.  It grabs the 
lowest and highest values and stretches them so that the lowest value becomes 0 and the 
highest value becomes 255, or whatever the range of the output display is. This is 
analogous to a linear stretch, and the old values are scaled proportionally between 0 and 
255.  The brightest values become brighter and the darker values become darker, but the 
overall contrast may not change.   
 

Histogram Equalization 
 
Reload your image making sure the No Stretch option is selected. Change the color “guns” 
as before to display layers 1, 2 and 3 in Blue, Green and Red colors respectively. In the 
Multispectral tab for the Raster group, select General Contrast to bring up the Contrast 
Adjust dialog box again. For the Method, choose Histogram Equalization and keep the 
Number of Bins to be 256. Click Apply and Close.  Right click in the 2D View with the 
image and click Fit to Frame…  
 

 
 
The image should appear very bright.  Histogram equalization reassigns the original values 
so that approximately the same number of pixels are in each bin, then distributes the bins 
among the range of output values in the new image.  This results in a histogram that is 
distributed across the entire range from the minimum to maximum possible DN values.  At 
the darkest and brightest values, bins with few pixels were combined.  The following from 
http://en.wikipedia.org/wiki/Histogram_equalization shows an example of how the 
histogram stretch is implemented 

http://en.wikipedia.org/wiki/Histogram_equalization
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Standard Deviation Stretch 
 
In the Contrast Adjust dialog box, choose Standard Deviations stretch.  Notice the image is 
not as bright as the histogram equalization method but shows better contrast.  Try using 
different values of standard deviation such as 0.5, 1.0, 3.0, 4.0.   The smaller values will give 
a brighter image while the higher values will produce a darker image.  A standard deviation 
stretch applies the stretch to the portion of the histogram that is the given number of 
standard deviations to either side of the mean.  With a larger standard deviation, more of 
the outlying values are included, and the image is more like the original.  With a smaller 
standard deviation, the pixels with extreme values are recalculated to have values closer to 
the center, giving the central bins more room to “spread out”, thus increasing the overall 
contrast. 

 
Let’s reset the image to no stretch.   Return to the Raster – 
Multispectal ribbon menu and choose General Contrast. 
Select Linear and click Apply.  Our image looks very much 
like it did when loaded with no stretch. 

You can go to the Adjust 

Radiometry menu and select 

No Stretch to remove a 

stretch from a 2D Viewer. 
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Level Slice 
 

 From the Raster – Multispectral ribbon menu choose General Contrast. Select 
Level Slice.   

 
 Specify a number of levels.  The example below has 5 levels. 

 
Level slicing does not operate on the statistics of the image, but rather groups pixels by 
their location on the DN value axis.  If you choose 5 levels, the 0-255 range will be divided 
into 5 groups each a range of 51 levels.  All pixels within a range will be assigned the same 
value.  You, in effect, change the image into discrete classes or “slices” based on the original 
DN value.   
 
A level slice is useful because the human eye cannot distinguish between fine variations in 
tone and color.  That is, the human eye cannot distinguish the 256 shades of gray recorded 
by the TM sensor.  A level slice allows us to group those classes in a way that may aid visual 
interpretation. 
 

 
 
 
When you are done examining the effects of the level slice operation you can close the 
viewer window.   
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Spatial Filtering  
 
Spatial filtering is designed to either enhance or smooth the changes in the image’s texture 
or spatial frequency.   It depends on both the pixel’s value and the values of surrounding 
pixels, and so is an area operation.  It usually works by passing a moving window, called a 
kernel over each pixel of the image.  The value of a pixel after the filtering operation is a 
function of the values of the initial DN of not only the raster cell in question, but also the 
adjacent cells.   
 

Sharpen (high pass filter) 
 

 From the Imagine ribbon menu bar choose the Raster tab and then 
click the Spatial button from the Resolution group 

 Next choose Convolution from the Spatial dropdown 
 Add Hg1_2345.img in the Input file box (if it’s not there already) 
 In the kernel dropdown choose 3x3 High Pass 
 Name and save the output file to your flash drive or student workspace 

 

 
 
There’s another way in ERDAS Imagine to implement the convolution filter that you may 
want to explore that gives instant previews of filters. Do you know what it is?  Hint, use the 
Help search to find out more.  
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_________________________________________________  
 
To see the results of the filter open a new viewer window and load the file you saved so you 
can compare it to the original file in another viewer window (recall from Intro to ERDAS 
Lab). 
 
 Zoom in to see if the boundaries between fields have become more distinct.  An advantage 
of using Imagine is that it will run a filter on all of the layers in the image.  Boundary areas 
are shown in very bright colors, while areas that are very smooth are shown in dark colors.  
We can also clearly see where the sensor introduced errors (striping) into the data.  
With a high pass filter, the high frequency components of an image are the areas which 
display a great deal of variation between pixels.  This may be an edge between two fields, 
the edge of a building, the boundary between two rock types, or a steep slope on a digital 
elevation model (DEM). A high pass filter enhances the differences in values and is useful in 
defining boundaries or enhancing the “rough” textures of an image.  The high pass filter in 
Imagine works by passing the following kernel over each pixel: 
 
 
 
 
 
The new value of a given pixel is obtained by multiplying each of the neighboring cells in 
the raster by the value in the appropriate position in the window and summing.  Notice that 
the center cell in the window has an opposite sign to the outside cells and that the outside 8 
cells sum to -6.8, the opposite of the center cell.  If the center cell is very similar to the 
surrounding cells, a value near zero will result.  If the center cell is very different, a high 
(positive or negative) number will result.   
 
Also notice that in this filter, the cells immediately to the sides of the center cell are given 
higher weights than the cells in the corners of the window.  Other weights can be used in 
high pass filters for different purposes, such as detecting East-West (horizontal) or North-
South (vertical) edges, or finding errors in scanner data.   
 

Smooth (low pass filter) 
 
The low frequency components of an image are the smooth areas where there is little 
variation in pixel values or the change is very gradual.  Examples of low frequency areas 
may be fields, forest cover, or water.  A low pass filter further reduces the differences 
between pixels and smoothes boundaries.  Usually a smoothing filter is simply an averaging 
function.  That is, the 9 cells in the 3x3 window are averaged to produce a new cell value.  
The following kernel is used: 
 
 
 
 

-0.7 -1.0 -0.7 
-1.0 6.8 -1.0 
-0.7 -1.0 -0.7 

1/9 1/9 1/9 
1/9 1/9 1/9 
1/9 1/9 1/9 
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A low pass filter may be useful in reducing the noise in an image before a classification is 
performed. A low pass filter can also be applied to a classification to reduce speckle. 
 

 Perform the smoothing operation in the same way we applied the high pass filter 
above, except select low for the filter type instead of high.  Remember to save the 
new file with a different name in your own workspace.  

 
 A new image is produced, just as before.  Zoom in to see if the boundaries between 

fields have become less distinct.  The image in general should be fuzzier than the 
original image. 
 

Vegetation Indices 
 
A vegetation index is a transformation that can be used to map the “greenness” of 
vegetation.  The goal of an index is to reduce the information contained in several spectral 
bands down to a single value, which is effectively sensitive to vegetation characteristics 
such as biomass, leaf area index (LAI), and percent vegetative cover while being insensitive 
to factors such as differences in the soil background.  For a series of images taken 
throughout the year, these indices can reveal patterns of vegetation growth, development, 
and harvest. 
 
Indices and simple ratios between two imagery bands are important tools in remote 
sensing and there are many different types with many purposes. Some indices can be quite 
complex involving several image bands and others are simply the ratio of two bands.  There 
are also other kinds of indices; for example some can be used to determine wetness, others 
for geologic purposes and so on. In this lab, we will look at one of the more commonly used 
indices. 
 
The Normalized Difference Vegetation Index (NDVI) is a normalized ratio of two bands, NIR 
and red (typically, TM bands 4 and 3), where NIR and Red are the DN values in the near IR 
and red spectral bands. 
 
The formula for NDVI is: 

NDVI= (NIR-Red) / (NIR + Red) 
 

NDVI 
 
We will calculate NDVI in Imagine. Under the Classification group in the Raster tab on the 
main ribbon bar, click on Unsupervised and select NDVI in the dropdown to open the 
Indices dialog box.  
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 Navigate to and select hg1_2345.img.   
 In Sensor options, choose: choose SPOT 4 XI if it is not already selected. 
 
Note: the reason we did not choose Landsat MSS in the Sensor selection is because of the 
unique combination of spectral bands in our image. It would be more accurate if Imagine 
would allow you to choose a function based on your layer combination, not the band 
combination from a particular sensor. 
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 Select Function: Choose NDVI and you should see the function described toward 
the bottom of the window.   

 Create an Output File in your personal directory and Click OK 
 

Note: the Data type for the output file is Float Single. This tells the computer to treat 
the data in the raster as numeric rather than categorical. 
 

 
 
Open a new 2D View, load your newly created NDVI file and click Fit to Frame… in each 
view: 

  
Make sure you click in the 2D View with the NDVI image to select it and in the Table ribbon 
menu click on the Show Attributes button. You should see a dialog like this at the bottom 
of your screen: 
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When you scroll the table down, you will see that the NDVI values have a range from about 
-0.29 to 0.70. You can also use the Inquire cursor to check a single NDVI value in the image.  
Alternatively, you can view the Metadata Histogram. 
 
 
Your NDVI image should look something like this one: 

 

 
 
 

Spectral Reflectance Curves 
 
By inspecting the Spectral Reflectance Curves graph (Fig 1) on the following page, find 
where the “red” portion of a line (0.6-0.72µm) is higher than the NIR (0.72-1.30µm) 
portion, which would give a negative value when plugged into the NDVI formula.  The only 
case where this is true is the “Clear Water” line.   
 
For “Dry Bare Soil”, the NIR value is slighter higher than the red value, giving a low positive 
NDVI result. 
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For “Green Vegetation” NIR is much higher than red.  Notice how the green portion is 
higher than both the blue and red portion of the EM spectrum, which explains why the 
vegetation would appear green to our eye. 
 
Looking at your NDVI image result, note the NDVI values for different areas of the image:  
 

 Pixels with values less than 0 are usually water   
 Pixels with low values close to 0 are bare areas (soils, pavement, etc.) 
 Pixels with higher values are vegetation 

 

 
Fig 1. 
 

Spectral Band Selection – Lab Exercise 
 
The selection of different band and color combinations changes the appearance of the 
image considerably.  Often features that are indistinguishable with one combination will be 
obviously different with a different combination.  Selecting band color combinations allows 
us to visualize parts of the spectrum that the sensors respond to, but our eyes do not.  We’ll 
continue to use our Hungary image for this lab exercise. 
 
To examine the effect of using different band combinations to identify crop types, fill out 
the following table for various combinations.  A map identifying the locations of the crop 
types is at the end of this lab.   
 
Layer in Imagine  TM band                       
 1     2  − green   
 2      3  − red 
 3      4  − near infrared 
 4      5  − middle infrared 
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Changing the band combinations may (or may not) give different colors for each crop.  Try 
several combinations and see which combination is most useful for identifying each crop.  
Which combinations cause the most confusion? You can use the snippet tool to create a 
small color patch and paste it into the appropriate cell of your answer matrix. 
 
 

Layer in Imagine  
Image Color 

Red Green Blue Corn Wheat Alfalfa Green 
Peas 

Sugar 
Beet 

Potato 

4 1 2       

4 1 3       

4 2 3       

4 2 1       

4 3 1       

4 3 2       

3 1 2       

3 1 4       

3 2 4       

3 2 1       

3 4 1       

3 4 2       

2 1 4       

2 1 3       

2 4 3       

2 4 1       

2 3 1       

2 3 4       

1 4 2       

1 4 3       

1 2 3       

1 2 4       

1 3 4       

1 3 2       
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Lesson 02 Outcomes 
 
By completing Lesson 02 you should be able to:  
 

1. Produce and interpret histograms in ERDAS Imagine 2016. 
 

2. Apply and understand the various spectral stretches. 
 

3. Apply low pass and high pass filters and see the results. 
 

4. Create an NDVI image and understand how various land covers will appear in it. 
 

5. Apply and use different band combinations to identify various crops. 
 


